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CIU-2 S-Link Program

The operating parameters of S-Link compatible programmable servos can be changed by using this S-Link
program. However, this software is used in the state in which the computer and servos were connected by using
the separately sold CIU-2/CIU-3 USB adapter, servo battery, and PC-Link adapter (or S-BUS hub).
*Note: The S-Link program is for Windows10/ Windows8.1/ Windows7/ Windows Vista use and is not compatible
with other OS.
*Note: This S-Link program is not compatible with the S907*SB Series and S3171SB.
Distribution & exemption of liability

Microsoft and Windows are registered trademark of Microsoft Corporation in the United States and other

countries.

Futaba Corporation shall not be responsible for any damage caused by use of this software without regard to
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legal foundation. Use this software based on agreement to this.

The copyright of this software and document resides with Futaba Corporation. Redistribution without the

approval of the copyright holder is prohibited.

Reverse engineering and modification of this software is strictly prohibited.

Downloaded Zip file extraction (decompression)

The downloaded S-Link_En_V1100 file is a Zip format file. Extract (decompress) this file.

1. With Windows Vista/XP, double click fi le S-Link_En_V1100 to display its contents.

2. Click “Extract all fi les”. The Extraction Wizard launches.

3. Extract (decompress) Zip fi le S-Link_En_V1100 to the same location as the Zip file storage location.

Extracted (decompressed) file confirmation

Let’s confi rm the extracted (decompressed) file.

1. At the end of extraction (decompression), a folder named S-Link_En_V1100 like that shown below is created.

2. Double click “S-Link_En_V1100”. The contents of the folder are displayed.

S-Link program installation



Before installing the S-Link program, confirm that all other applications are closed.
Close all virus check and other resident programs, if any.
This program needs Microsoft .NET Framewowk 3.5.
If .NET Framework 3.5 is not installed in your computer, it is downloaded and installed from the Internet
automatically.
Please note: your computer must be connected to the Internet.

1. Select and double click the folder named S-Link_En_V1100 created by downloaded Zip file extraction

(decompression). The contents of the folder are displayed.

2. Double click the EXE file named “setup”.

3. If “.NET Frameforwk 3.5. Setup” window appears, click “Accept”.

.NET Frameforwk 3.5 is downloaded and installed from the Internet automatically.

4. After “Welcome the S-Link Setup Wizard” window appears, click “Next”.



5. Chosen to install this program for “Just me”, or for “Everyone”. Confirm the program folder (save destination) at

“Folder:” and click “Next”. To change the directory, click “Browse…” and specify the folder which is to save the

program and then click “Next”.

6. After “Confirm Installation” window appears, click “Next”.

7. After “Installation Complete” is displayed, click “Close”.

The above completes S-Link program installation.



S-Link program removal (uminstall)

1. Select and double click the folder named S-Link_ En_V1100 created by downloaded Zip file extraction

(decompression). The contents of the folder are displayed.

2. Double click the EXE file named “S-LinkSetup-en”.

3. After the “Welcome to the S-Link Setup Wizard” window opens, select “Remove S-Link” and click “Finish”.

4. After the “Removing S-Link” window opens and the “Installation Complete” screen

appears, click “Close”. This completes S-Link program removal (uninstall).



How to use the S-Link program

*Installing the CIU-2 device driver
A CIU-2 USB adapter is necessary to execute this software. Before using this software, please install the CIU-2
device driver. If the CIU-2 USB device driver has already been installed, advance to the next step.
*The CIU-2 device driver is available at the download corner of your Futaba impoter’s home page.

1. Connect the CIU-2/3 to the USB port of the computer to be used. The CIU-2/3 LED lights green.

2. Connect the PC link adapter or S.BUS hub to the CIU-2/3.

3. Connect the servo to the PC link adapter or S.BUS hub.

4. Finally, connect in battery order.

Note: When connecting and setting another servo disconnect thebattery with the CIU-2 inserted at the USB port
of the computer, connect the next servo, and then reconnect the battery.



Starting the S-Link program

1. In the state in which the servo was connected to a computer by the previously described connection method,

double-click the “S-Link Shortcut” icon.

S-Link Shortcut an icon

2. The parameters setup screen shown below appears and the CIU-2 lamp of the screen lights green.



*When the CIU-2 lamp of the screen did not light green and the following message was displayed the CIU-2/3 is
not properly connected to the computer. Click “OK” and check the connection.

*Connecting the S-Link program and servo
When connecting and setting 1 servo as shown in the preceding fi gure, automatically display the ID and current
setup parameters of that servo by clicking the “Connect” button or selecting “Connect” from the “Tool” menu. The
Servo lamp on the screen lights green.

When connecting multiple servos simultaneously using a S.BUS hub tick the check box at the left side of “ID
Enable”, input the ID of the servo you want to set, and click the “Connect” button. The current setup parameters of
that servo are displayed and the Servo lamp on the screen lights green.

When the Servo lamp on the screen did not light green and the following message was displayed, click “OK” and
check the following:



Servo fi rmly connected?

A battery with suffi cient capacity connected?

In the state in which “ID Enable” is ticked, does the manually input ID and the displayed ID match the

connected servo? (When 1 servo is connected, untick “ID Enable”)

*Setting and adjusting the parameters
Each parameter is adjusted.
* Refer to “Description of parameters” (P13) for a description of the contents and the method of operating each
parameter.
*Writing the setup parameters and initializing the servo

1. Write the set contents to the servo by clicking the “Write” button. The set contents can also be written to the

servo with “Write” of the “Tool” menu.

When writing of the setup parameters ends normally the message “Succeeded in the data writing.” shown below
(left side) is displayed. End writing by clicking “OK”. If the message “Failed in the writing data.” shown below (right
side) is displayed, click “OK” and check the following:

Servo is fi rmly connected?

Battery with suffi cient capacity is connected?

To return the contents set in the servo to the factory setting initialize the servo by clicking the “Default” button. The



setup contents of the servo can also be initialized with “Default” from the “Tool” menu.

* To initialize the servo, its ID must be valid. When a servo whose ID was automatically recognized at independent
servo setting is initialized an ID Warning message is displayed. Click “OK” and then disconnect the S-Link
program and servo by clicking the “Disconnect” button. After ticking the check box at the left side of the “ID
Enable” and reconnecting the S-Link program and servo, “Default” is executed.

When initialize is executed, the confi rmation message shown below is displayed. Click “OK”.

When initialization ends normally the message “Succeeded.” shown below (left side) is displayed. End by clicking
the “OK” button. If the message “Connection error!” shown at the below (right side) was displayed click “OK” and
check the following:

Servo is fi rmly connected?

Battery with suffi cient capacity is connected?



2. Click the “Disconnect” button. Or select “Disconnect” from the “Tool” menu.
3. Remove the servo.

Note: Do not pull out the lead wire or turn off the power while parameters are being written.
Note: After the parameters are rewritten, check the operating direction, etc. by static test.
*Saving setup parameters and reading save setup parameters
The set contents can be saved and read only in the “Connect” state in which the servo lamp is green.

Saving setup parameters to file

1. Select “Save” or “Save as” from the “File” menu.

* “Save” rewrites the currently displayed setup parameters.



2. When creating a new file with “Save as” since a data save dialog box opens, select the save location and save

the setup date of the parameters setup screen to the computer as a fi le by clicking “Save”.

* However, S.BUS CH setting is not saved.

Reading save setup parameters

1. Select “Open” from the “File” menu.

2. When saved setup parameters are read since the message shown below, which automatically transfers the

contents to the servo, is displayed, to execute the read command, click “OK”.

3. Display the setup data on the parameter setup screen and automatically transfer its contents to the servo by

selecting the save location at the data save dialog box and clicking “Open”.

However, to memorize that data at the servo, click the “Write” button of P8 and write the data to the servo or

execute “Write” from the “Tool” menu.



*Disconnecting the S-Link program and servo and ending the S-Link program

1. Disconnecting the S-Link program and servo

After the end of work and before turning off the servo power, terminate communication by clicking the

“Disconnect” button or by selecting “Disconnect” from the “Tool” menu. The servo lamp goes off and the S-Link

program and servo are disconnected.

2. Ending the S-Link program

To end the S-Link program, click “Exit” of the “File” menu.

If the CIU-2/3 is disconnected from the computer USB port while the S-Link program is starting, the message
shown below is displayed. However, there is no special problem with this confi rmation message. Click “OK” and
check the CIU-2/3 and computer USB port connection.



Description of function of each parameter

*Parameter screen
The parameter screen has the following functions:
* There are some functions that cannot be used depending on the servo used. When a set value is not appropriate
oscillation may occur, but this is not a servo trouble. However, connecting an oscillating servo may cause the
motor to overheat and lead to trouble. Immediately return the setting to its original value.

Set values can be changed by clicking or dragging the dial and lever of each parameter. In addition, after a dial or
level is selected by clicking, operation by mouse wheel and keyboard arrow keys is also possible.



1) “Servo position data display & setting”
2) “Connect” button
3) “Disconnect” button
4) “Connection status display”
5) “ID. S.BUS CH setup”
6) “Neutral Ofset”
7) “Travel Adjast”
8) “Dead Band”
9) “Boost”
10) “Boost ON/OFF”

11) “Speed Control”
12) “Damper factor”
13) “Stretcher gain”
14) “Soft Start ”
15) “Reverse”
16) “Stop Mode”
17) “Buzzer”
18) “Smoother”
19) “Write” button
20) “Default” button

Servo position information display and setting
This setting changes the servo position. Servo operation after a parameters change can also be checked.

1. Position information meter (angie)

The meter needle displays the servo position and is linked with the slider position.

2. Position information PWM width (ys)

Displays the servo position by PWM width

3. Position information Rate (%)

Displays the servo position with the center as 0% and 60 degrees as 100%.

4. Position change text box

Displays the servo position by PWM width. The position can be changed with the up/down buttons at the right.

5. Slider

When the slider is moved while clicking with the mouse, the servo operates over the maximum left and right

600 range with the center as Odegrees.

6. Moving range

Displays the center position offset by neutral adjustment and the moving range by travel adjustment.

7. Direct position setting

When the button designated PWM width is clicked, the servo moves to the specified PWM width position.

“Connect” and “Disconnect” buttons
Connect and disconnect communication between S-Link program and servo.



1. “Connect” button

When the “Connect” button is pressed, the program communicates with the servo and reads the parameters of

that servo and displays them on the screen.

2. “Disconnect” button

When the “Disconnect” button is pressed, communication with the servo is disrupted. The “Disconnect” button

is ineffective if servo recognition by “Connect” is not successful.

Connection status display 
Displays the CIU-2/3 and computer and S-Link program and servo connection status.

1. CIU-2 lamp

When the CIU-2/3 is connected to the computer, this lamp lights green.

2. Servo lamp

When the servo was connected by “Connect” button, this lamp lights green.

3. S.BUS2 lamp

When the connected servo is compatible with the S-BUS2 system this lamp lights green.

ID. S.BUS CH (channel) setting

1. ID

When connecting 1 servo to the CiU-2/3 untick the “ID Enable” check box, then click the “Connect” button or

select “Connect” from the “Tool” menu. The parameters are read and the servo ID is displayed. The ID cannot

be changed. If the “ID Enable” check box is ticked, the Warning message show below (left side) will be

displayed.



When connecting multiple servos to the CiIU-2/3 tick the “ID Enable” check box, input the ID No. of the ID seal

attached to the servo whose parameters are to be read, and click the “Connect” button or select “Connect”

from the “Tool” menu. If the ID is a mismatch, the Error message shown below (right side) will be displayed and

communication will not be established.

2. S.BUS CH (channel) (S.BUS servo only) 

This is the channel assigned to the servo when used with the S.BUS system. Always assign the channel before

use. When the “Connect” button is clicked, the CH number of the servo is displayed. CH assignment can be

changed here.

3. “Change” button

This button is used with the S.BUS system and when changing the channel assigned to the servo.

How to change S.BUS CH (channel) change

“Only S.BUS CH (channel) setup is completed by clicking the “Write” button.
Neutral Offset
The neutral position can be changed. However, when the neutral position was changed substantially, the servo
throw may be exceeded at maximum travel and a dead band within which the servo does not operate may be



created.
(Setting range: -32.0deg to +31.75deg based on the default position)

1. Set value change dial

Changes the offset set value.

2. Set value numerical display

Displays the set value as a numerical value. A numerical value cannot be input.

3. Offset displays

Displays the offset graphically.

4. Reset button

Returns to the set value written last.

Travel Adjast
The maximum left and right travels centered about the neutral position can be set independently. (Setting range:
50% to 149.6%)

1. Left Travel adjustment set value change dial

Changes the travel adjustment set value.

2. Right Travel adjustment set value change dial

Changes the travel adjustment set value.

3. Set value numerical display

Displays the travel adjustment as a numerical value. A numerical value cannot be input.

4. Reset button

Returns to the set value written last.

Dead Band
The stop position dead band range (angle) can be set. (Setting range: 0.00deg to 3.98deg )



Relationship between dead band set value and servo operation
Dead band small : Stop position dead band width small. The servo immediately responds to minute signal
changes.
Dead band large :Stop position dead band width larg. The servo does not respond to minutes signal changes.
Note: If the dead band width angle is too small. since the servo will operate continuously. the current consumption
will increase and the life of the servo will be shortened.

1. Set value change dial

Changes the dead band set value.

2. Set value numerical display

Displays the dead band as a numerical value. A numerical value cannot be input.

3. Reset button

Returns to the set value written last.

Boost
The minimum boost applied to the internal motor when the servo is driven can be set. (Setting range: 3% to 45%)
Since the motor is not started by the minimum boost, essentially it feels like the dead band had widened.
Therefore, adjust the minimum boost at starting so that the motor immediately starts.
Relationship between boost set value and servo operation
Boost small : Corresponds to minute commands and operation becomes smooth.
Boost large : Initial response is good and output torque is large, but if too large, operation becomes rough.

1. Set value change dial

Changes the boost set value.

2. Set value numerical display

Displays the boost as a numerical value. A numerical value cannot be input.

3. Reset button

Returns to the set value written last.

Boost ON/OFF
Switches between the mode that turns on the boost function only when the servo is operated at slow speed and



the mode that turns on normal boost.
ON at slow speed (Normally use at this setting.)
Normally ON (When wanting quick operation)

Speed Control
Sets the operating speed. The effect of voltage, load torque, motor, and other changes can be eliminated and the
speeds of multiple servos can be matched.
(Setting range: Max. 0.047 sec/60deg to 12 sec/60deg or none)
However, note that even if set to over the maximum speed of the servo at each operating voltage, the speed does
not become a speed over the maximum speed.

1. Set value change dial

Changes the speed control set value.

2. Set value numerical display

Displays speed control as a numerical value. A numerical value cannot be input.

3. Reset button

Returns to the set value written last.

4. Speed control enable/disable

When checked, speed control setting is enabled.

(The actual servo speed upper limit depends on the performance of each servo.)

Damper factor
The characteristics when the servo stops can be set. (Setting range: 0 to 255)
When smaller than the standard value the characteristic becomes an overshoot (return after traveling too far)
characteristic. When the value is large, the stop setting applies the brake before the stop position.
Makes it especially difficult for the servo to hunt (phenomena which causes the servo to oscillator) by suppressing
overshoot due to inertia when a large load is applied.
When hunting occurs even though Dead Band, Stretcher, and other parameters are suitable adjust this parameter
to a value larger than the initial value.
Relationship between damping set value and servo operation
Damping small : When you want to overshoot. Set so that hunting does not occur.
Damping large : When you want to operate like braking was applied. However, it feels like the servo response is
poor.
Note: When used in the state in which hunting occurs not only will the current consumption increase, but the servo
life will also be shortened.



1. Set value change dial

Changes the damping gain set value.

2. Set value numerical display

Displays the damping gain as a numerical value. A numerical value cannot be input.

3. Reset button

Returns to the set value written last.

Stretcher gain
The servo hold characteristic can be set. (Setting range: x0.125 to x8)
When the current servo position deviates from the target position the torque which attempt to return the servo to
the target position can be adjusted. This is used to stop hunting, etc., but the hold characteristic changes as
shown below.
Relationship between stretcher set value and servo operation
Stretcher small : Servo holding force weak
Stretcher large : Servo holding force strong
Note: When the stretcher is large. the current consumption increases.

1. Set value change dial

Changes the stretcher gain set value.

2. Set value numerical display

Displays the stretcher gain as a numerical value. A numerical value cannot be input.

3. Reset button

Returns to the set value written last.

Soft Start
Restricts operation in the specified direction the instant the power is turned on. By making this setting, only the
first operation when the power is turned on slowly moves the servo to the specified position.
(Setting range: 0.8 sec/60deg to 12 secs/60deg or none)

1. Set value change dial

Changes the soft start delay set value.



2. Set value numerical display

Displays the soft start delay as a numerical value. A numerical value cannot be input.

3. Reset button

Returns to the set value written last.

4. Soft start delay enable/disable

When checked soft start display setting is enabled.

Servo reverse (normal/reverse)
The direction of rotation of the servo can be changed.
When you want the servo to rotate in the direction opposite the standard direction, set to “Reverse”.

Stop Mode (Free/Hold)
The state of the servo when the servo input signal was disrupted can be specified.
However, when “Free” the servo becomes weak and when “Hold” the angle immediately before the signal was
disrupted is held.
The servo hold mode can be set even with AM and FM systems.
However, there is no fail safe function.

Buzzer (ON/OFF)
When alarm was set to ON when the servo power was turned on first without the transmitter emitting radio waves
the servo continues to emit a buzzer sound 2.5 times/second.
(Even when transmitter radio waves are output first, the buzzer sounds until the servo signal is output normally,
but this is normal.)
When the transmitter power was turned off first at the end of operation, the buzzer sounds 1.25 times/second as
an alarm that you forgot to turn off the servo power.
However, this may not occur depending on the type of servo.



(If the servo connector is disconnected while the receiver power is on, since an S-BUS connected servo will be
erroneously recognized and a confirmation sound may be generated, do not disconnect the connector while the
power is on.)
Note: Since a buzzer sound is generated by oscillating the servo motor and current is consumed and heat is
generated, do not operate more than necessary or continue to sound the buzzer for a long time.
Smoothe (ON/OFF)
This function makes servo operation smooth. Set it according to your taste. Normally set it to ON. Set it to OFF
when want especially quick operation.
When the smoother function was set to ON and the servo was operated the distance up to the target position is
changed in steps so movement is smooth.

Write button
When the parameters on the S-Link main screen are changed, the servo parameters are temporarily changed and
when the power is turned off they return to their value before the change. Therefore, to record the changed
parameters at the servo, click the  Write” button.

Default button
The “Default” button returns the servo parameters to their factory settings.
*”Default” requires a valid ID. When the ID is automatically recognized by independent servo setting click the
“Disconnect” button to disconnect the S.Link program and servo. After ticking the check box at the left side of “ID
Enable” and reconnecting the program and servo with the “Connect” button, execute “Default”.

Other menus

*Tool menu
The Tool menu has “Language” and “Settings” functions, in addition to the “Connect”, “Disconnect”, “Write”, and
“Default” functions described up to here.
“Language”
This function allows you to select the S-Link Program display language from among English, Japanese, and



Deutsch.

“Settings”
When “Settings” in the “Tools” menu is clicked, the screen shown below appears.

“When the “When ending, data on display is not saved.” check box is unticked before starting the parameters data
at the end of the last session is displayed.
“When the “S.BUS2 channel is not displayed.” check box is ticked, the S-BUS2 system dedicated CH display at
the S.BUS CH (channel) setup window described on P15 is hidden.

After changing the setting, close the window by clicking “Apply”.



*Help menu
There is “S-Link Help” and “About” in the help menu.
“S-Link Help” displays a description of the parameter functions.
“About” displays the S-Link program version and a link to the Futaba website.
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